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Sažetak: Rad prikazuje tehnologiju izrade metalne ladice (materijala DC01 prema EN 10130:1991) od konstruiranja 
uz upotrebu računala i konačno do slanja CNC programa na strojeve za deformiranje i izradu ladice tj. primjenom 
CAD-CAM povezivanja. Korištenjem prikazanog CAD-CAM pristupa u proizvodnji ladice, proizvodnja se može 
optimizirati i lako kontrolirati, a sve u cilju brže, kvalitetnije i efikasnije proizvodnje. 
 
Ključne riječi: – oblikovanje lima 

– metalna ladica  
– modeliranje 

 
Abstract: The paper presents the technology for metal drawer manufacture (material DC01 according to EN 
10130:1991) from construction by usage of computer, and finally to sending of the CNC program on machines for 
metal forming and drawer construction, i.e. by implementation of the CAD – CAM connection. With the use of the 
presented CAD – CAM approach in the production of a drawer, production can be optimized and easily controlled, 
with the goal of a faster and more efficient production of a higher quality. 
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1. UVOD 
 
Današnji CNC programi izrađuju se poluautomatski ili
automatski, korištenjem softvera za programiranje koji
sadrže precizne informacije o stroju i alatima [1]. 
Programer odabire obradnu strategiju, izabire alate, i
optimizira parametre te definira softveru za
programiranje u cilju generiranja CNC programa. Softver 
za programiranje automatski određuje optimalne obradne
nizove i proizvodi CNC programe bez pogreške. Tijekom
proizvodnje svaki dio mora proći kroz nekoliko stanica,
limovi se probijaju, ili se koriste laseri za izrezivanje,
grickaju se, oblikuju, plitko vuku i savijaju na strojevima
za savijanje. Brza i rentabilna proizvodnja znači izradu
konačnog oblika u što je manje koraka, a korištenjem
optimiziranog modeliranja povezanog s CNC
programiranjem, te pravilnim  definiranjem tehnologija
oblikovanja moguće je postići traženo [2]. Dakle pri
izradi zadane metalne ladice bit će prikazan pristup
naprednog modeliranja pomoću SolidWorks [3] programa 
s konačnom svrhom izrade razvijenog oblika limene
ladice, da bi se napravio CAD oblik pogodan za stvaranje
CNC koda za daljnju proizvodnju. Konačni proizvod koji
inženjer izrađuje na zaslonu je trodimenzionalan, dok je
lim koji će se koristiti za izradu proizvoda  ravan, pa se

 1. INTRODUCTION 
 
Today, CNC programs are created automatically or half -
automatically, by the use of programming software which 
contains precise information’s about machines and tools
[1]. The programmer selects the work strategy, chooses 
the tools, optimises the parameters and defines the 
programming software with the goal of CNC code 
generation. Software for automatic programming 
determines the optimal working sequence and produces 
CNC programs without mistakes. During production,
every part has to go through several stations, sheet metal 
is punched, or cutting lasers are used, nibbled, shaped, 
shallow drawn and bended on the bending machines. Fast 
and efficient production means the creation of a final 
shape in the smallest amount of steps, by using optimal 
modelling combined with CNC programming, and with 
the correct definition of forming technologies it is 
possible to obtain the requirements [2]. In the 
manufacture of the given metal drawer, the approach of 
advanced modelling with the use of the SolidWorks [3]
program will be presented with the final purpose of 
creating the developed shape of the sheet metal drawer, in 
order to create a CAD code for further production. The 
final product that the engineer creates on the screen is 
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stoga mora početi s „razvijanjem“ virtualnoga
trodimenzionalnog dijela. Proces razvijanja ravnog dijela
iz crteža gotovog proizvoda određuje kako treba biti
odrezan ili probijen početni oblik lima. Rupe, oblikovani
dijelovi, i crte savijanja također se razrađuju. Podaci se
tada prenose u softver za programiranje. Na osnovi
razvijenog dijela izrađuje se CNC program za sve
strojeve koji se koriste za proizvodnju dijela i CNC
program definira stroju koje operacije treba izvršiti.  ToPs
program bit će korišten u ovom radu za izradu CNC koda 
za obradu na strojevima zbog toga što znatnije skraćuje
vrijeme obrade i omogućuje uštedu materijala. 

three-dimensional, while the sheet metal that will be used 
for product creation is straight, so it has to begin with the 
“development” of a virtual three-dimensional part. The 
process of the development of a straight part from the 
drawing of a final product determines how the initial 
shape has to be cut or punched. Holes, shaped parts, and 
lines of bending are also elaborated. Information is then 
transferred into the programming software. On the basis 
of a developed part, a CNC program is created for all 
machines that are used in part production and the CNC 
defines to the machine the operations that it needs to 
execute.  The ToPs program will be used in this work for 
the creation of a CNC code for manufacture on machines 
because of its feature of considerably shortening
production time and allowing for material savings. 

 
2. MODELIRANJE LADICE U 

SOLIDWORKSU KORIŠTENJEM 
NAPREDNIH SHEET METAL FUNKCIJA  

 
Najbrži i najefikasniji način modeliranja u SolidWorksu je 
korištenjem Sheet Metal funkcija, dok se konstruiranje
Solida te naknadno pretvaranje u sheet metal koristi samo
u iznimnim slučajevima kao npr. kod koničnog savijanja.
SolidWorks omogućuje izradu dijelova (part), njihovo 
sklapanje u jedinstveni sklop (assembly) te izradu crteža
koji obično predstavljaju dijelove sklopa. Sklop ladice bit
će napravljen od pet dijelova: 

1) Ladica_korito, 
2) Ladica_leđa, 
3) Ladica_pregrada, 
4) Ladica_zadnja i 
5) Ladica_prednja. 

Za svaki dio sklopa izradit će se i odgovarajući crtež, kao
i za konačni sklop koji će se sastojati od navedenih
dijelova. Glavni koraci u procesu modeliranja ladice dani
su u sljedećem popisu: 

• Modeliranje alatima Sheet Metal 
Koriste se alati koji su specifični za modeliranje dijelova
od lima i to tipovi: Flange, Tabs i Added Bends te alati za 
razvijanje; 

• Korištenje alata za oblikovanje (Forming 
Tools) 

Koriste se alati za oblikovanje kako bi se oblikovao dio
od lima. Alati mogu biti korišteni onakvi kakvi jesu,
izmijenjeni, ili prepravljeni od postojećih; 

• Crteži dijelova od lima 
Izrada crteža korištenjem dijelova od lima ima s nizom
mogućnosti; 

• Korištenje simetrije 
Simetrični modeli mogu se izraditi kao djelomični modeli
i zrcaljeni korištenjem opcije zrcaljenja modela (Mirror 
Bodies) itd. 
Funkcija Closed Corners ili funkcija za približavanje
rubova lima može produžiti jednu ili dvije rubne površine
dovoljno da se naprave tri moguća načina izgleda rubova:
1. Približavanje unutarnjih rubova 

  
2. DRAWER MODELLING IN SOLIDWORKS

BY THE USE OF ADVANCED SHEET 
METAL FUNCTIONS 

 
The fastest and the most efficient method of modelling in 
SolidWorks is with the use of the Sheet Metal function, 
while construction of Solid and then afterwards 
transformation into sheet metal is used only in 
exceptional cases like, e.g., in cone bending. 
SolidWorks enables part creation, joining of parts into one 
unique assembly and the creation of parts that usually 
represent parts of the assembly. Assembly of the drawer 
will be created from five parts:  

1) Drawer_bed, 
2) Drawer_back, 
3) Drawer _compartment, 
4) Drawer _last and 
5) Drawer _front. 

For every part of the assembly the correspondent drawing 
will also be created, and also for the final assembly that 
will be made from the mentioned parts. The main steps in 
the modelling of a drawer are given in the next list: 

•  Modelling with  Sheet Metal tools 
Tools are used that are specific for modelling of sheet 
metal parts and they are: Flange, Tabs and Added Bends, 
and tools for development;   

• Use of Forming Tools 
Tools are used in order to form a piece of sheet metal. 
Tools can be used in the way they are, changed, or 
reconstructed from the existing; 

• Drawings of sheet metal parts  
Creation of sheet metal parts has a series of possibilities; 

• Use of symmetry 
Symmetric models can be constructed as a partial model 
that can be mirrored with the use of the option Mirror 
Bodies etc. 
 
The function Closed Corners, or the function for the 
approach of sheet metal edges, can elongate one or two 
edge surfaces enough to create three types of edges 
appearance: 



Eng. Rev. 28-1 (2008) 73-83 75 
____________________________________________________________________________________________________________________________________________________ 
 

Unutarnji rub do unutarnjeg ruba (slika 1.a.). U tom 
slučaju obje su stranice produžene da bi se zbližile u
zajedničkom rubu. To može biti vrlo korisno kada se
koristi rubno zavarivanje na vanjskoj stranici i potrebno
je minimalno omatanje.  
2. Preklapanje ruba 
U tom slučaju (slika 1.b.) jedna je stranica produžena na
vanjsku površinu druge stranice i predstavlja potpuno
preklapanje na vanjsku površinu. 
3. Približavanje plus preklapanje 
Predstavlja produžavanje unutarnjih površina s
unutarnjim preklapanjem (slika 1.c.). U tom slučaju jedna 
je površina produžena prema unutrašnjosti druge stranice,
a vanjska je površina produžena do vanjske površine 
druge stranice. Općenito, taj se tip rubova teško postiže
standardnom funkcijom Closed Corner, ali može biti
jednostavno modeliran. Za što efikasnije modeliranje 
bitno je na nacrtu uočiti profil koji je zajednički svim
daljnjim savijanjima, polazišnu bazu s kojom se može
riješiti najveći broj savijanja. U slučaju dijela
Ladica_prednja to je okomita poprečna ravnina (slika 2).

1. Approaching of the inner edges  
Inner edge to inner edge (Figure 1.a.). In this case, both 
sides are elongated in order to close in a joint edge. This 
can be useful when the edge welding is used on the outer 
side and a minimal envelopment is needed. 
2. Edge overlapping 
In this case (Figure 1.b.), one side is elongated on an 
outer surface of the second side and represents the total 
overlapping on the outer side. 
3. Approach plus overlapping 
Represents the elongation of the inner surfaces with the
inner overlapping (Figure 1.c.). In this case, one surface 
is elongated towards the inner part of the second side, and 
the outer surface is elongated towards the outer surface of 
second side. Generally this type of edge is hard to achieve 
with standard the function Closed Corner, but it can be 
simply modelled. For more efficient modelling, it is 
important to notice on the drawing the profile that is 
mutual to all further bendings, the starting base with 
which the greatest number of bendings can be solved. In 
the case of the part Drawer_front, it is the vertical 
transverse plane (Figure 2). 
 

 

 

 

 

 

 

 

 
 
 

Slika 1. Tri moguća načina izgleda rubova 
Figure 1. Three possible types of edges 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Slika 2. Profil dijela Ladica_prednja 
Figure 2.  Profile of the part Drawer_front 

 

1. a. 1. b. 1. c. 
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Odabirom funkcije Base Flange stvorit će se taj profil u
ravnini Front, jednostavnim alatima za skiciranje te će se
kotirati zadanim dimenzijama.  U Base Flange funkciji 
potrebno je definirati i 3D komponentu, kao i radijuse 
savijanja i ubaciti tablicu iz koje će Solidworks izvlačiti 
korekturne faktore (slika 3). Sva će savijanja biti
automatski izvedena sa zadanim radijusima te je to i
dokaz brzine pristupa. (Napomena: ovdje je rađena
polovica izratka te je kasnije korištena Mirror funkcija, 
jer se time skraćuje vrijeme).  

 With the selection of the function Base Flange, this 
profile will be created in the plane Front, with simple 
tools for sketching, and it will be dimensioned with the 
given dimensions. In the Base Flange function, it is also 
necessary to define the 3D component and radius of 
bending and import tables from which SolidWorks will 
draw the corrective factors (Figure 3). All bendings will 
be automatically executed with a given radius, and this is 
also proof of the access speed. (Annotation: here half of 
the part was done, and later the Mirror function was used, 
because it shortens time). 

 

 
 

Slika 3. Tablica korekturnih faktora 
Figure 3.  Table of corrective factors 
 
Na slici 3 prikazane su opcije funkcije Base Flange. Pod 
poljem Direction 1 odabiru se smjer izvlačenja profila i 
duljina izvlačenja. Pod poljem Direction 2 je opcionalni
smjer izvlačenja. Pod poljem Sheet Metal Parameters
unosi se vrijednost debljine lima i radijus savijanja. Za
polje Bend Allowance (dodanost savijanju) moguće je
odabrati između K-faktora i tablice savijanja. Kada je lim
savijen, da bi se razradilo koja je prava duljina tog dijela
potrebna, treba izračunati dodanost savijanju (bend
allowance) ili umanjenost savijanju (bend deduction) 
koje govore koliko treba dodati ili oduzeti dužine da bi se
dobila tražena vrijednost. Jedini pravi djelotvorni način
da se radi s točnom dodanosti savijanju jest reverzibilnim
inženjeringom tako da se uzme uska traka materijala,
savije se i tada se izmjeri da se izračuna dodanost
savijanju. Dodanosti savijanju mogu biti izmjerene za
mnoštvo materijala i scenarija i tada tabelirane, a tablice
se zatim mogu koristiti u programu za izradu preciznog 
modela. Mnogi CAD programi ipak rade dodanosti 
savijanja automatski korištenjem proračuna K-faktora (ili 

 In Figure 3, the options of the Base Flange are shown.
Under the field Direction 1, a direction of profile drawing 
is selected as well as the length of the draw. Under the 
field Direction 2 is an optional direction of drawing. 
Under the field Sheet Metal Parameters is imported the 
value of the thickness of sheet metal and radius of 
bending. For the field Bend Allowance, it is possible to 
choose between the K-factor and the table of bending. 
When the sheet metal is bent, in order to elaborate which 
length is the real length of the part that is needed, it is 
necessary to calculate bend allowance or bend deduction, 
because they reveal how much it is necessary to give or 
take from the length in order to gain the required value. 
The only right and effective method of working with the 
exact bend allowance in bending is reverse engineering,
by taking a narrow strip of material, bending it, and then 
calculating the bend allowance. These allowances for
bending can be measured for multiple materials and 
sceneries and then put into tables for use of such tables in 
a program for the creation of a precise model. Many CAD 
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Y-faktora u slučaju Pro-E gdje je Y-faktor = K-faktor x 
π/2). Dodanost savijanju izračunava se korištenjem
K-faktora kao što slijedi [1]: 

programs, however, create bend allowance automatically 
with the usage of K-factor calculus (or Y-factor in case of 
Pro-E where Y-factor = K-factor x π/2). Bend allowance 
is calculated with the usage of K-factor as follows [1]: 

( ) 180/AKTRBA ⋅+⋅= π                                                                    (1) 

R – unutarnji radijus savijanja, 
K – K-faktor, koji je t/T, 
T – debljina materijala, 
t – udaljenost unutrašnje strane do neutralne plohe, 
A – kut savijanja u stupnjevima (kut kroz koji je materijal
savinut). 
 
Slika 4 prikazuje izvučeni profil sa slike 2 i vrijednosti sa
slike 3 s razlikom što je pod radijusom savijanja korištena
vrijednost 1 mm. 
 

 R – inner radius of bending, 
K – K-factor, which is t/T, 
T – thickness of material, 
t – distance of the inner side to the neutral plane, 
A – Bend angle in degrees (angle through which the 
material is bended). 
 
Figure 4 shows the drawn profile from Figure 2, and 
values from Figure 3, with the difference that under a 
radius of bending, the value of 1 mm was used. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Slika 4. Gotov profil 
Figure 4.  Finished profile 
 
Tablica savijanja (Bend Table) specifična je tablica 
materijala koja sadrži proračune savijanja temeljene na 
debljini lima i radijusu savijanja, a formira se kao
Excelova datoteka i ima *.xls datotečnu ekstenziju. Ta se
tablica lako unosi u  SolidWorks (odabire se Insert -> 
Sheet Metal -> Bend Table -> From File). Također se
može odabrati iz Use Bend Table padajućeg izbornika u
okviru Sheet-Metal. Tablica savijanja također se može
napraviti korištenjem datoteka za primjer i Excela. 
Primjeri se mogu naći pod instalacijskim direktorijom
i: lang\<language name>\Sheetmetal Bend Tables. Slika 
5 prikazuje jednu takvu tablicu savijanja za vrijednost
smanjenja savijanja gdje se vide vrijednosti umanjenosti
savijanja pri različitim vrijednostima radijusa i debljine
lima.  
Bočne stranice izvedene su korištenjem Edge Flange
funkcije koja je u mnogočemu slična Base Flange
funkciji. Nacrta se skica savijenog ruba, odaberu se
radijusi i tablice savijanja i rub je gotov. Potrebna
popuštanja na mjestima gdje bi dolazilo do ulaska jednog
dijela u drugi, rade se klasičnim extrude/remove material
funkcijama (slika 6). 
 

 The bend table is a specific table of material that contains 
calculations of bending based on the thickness of sheet 
metal and the radius of bending, and it is formed as an
Excel file and it has  the *.xls file extension. This table is 
easily imported into SolidWorks (the sequence to select is 
Insert-> Sheet metal-> Bend Table -> From File). Also it 
can be selected from Use Bend Table from the falling 
menu in the frame of Sheet-Metal. The Bend Table can 
also be created with the use of files of examples and 
Excel. Examples can be found under the installation 
directory i: lang\<language name>\Sheetmetal Bend 
Tables. Figure 5 shows one such bend table for the value 
of the bend deduction, where the values of bend 
deduction can be seen with different values of radius and 
thickness of sheet metal.   Flange sides are created with 
the use of the Edge Flange function that is in many ways 
similar to the Base Flange function. A drawing of a 
bended edge is sketched, the radii are selected, the bend 
tables and the edge are finished. The necessary releases in 
places where one part enters into another, are done with 
the classic extrude/remove material functions (Figure 6). 
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Slika 5. Tablica savijanja 
Figure 5. Bend table 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Slika 6. Primjer izreza 
Figure 6.  Representation  of a cut-out 

 
Savijanja je moguće izvesti korištenjem napredne Miter 
Flange funkcije, ali se sporije definira svako savijanje
nakon Base Flange Elementa. Još jedna korištena 
funkcija kod izrade ladice je Hem (slika 7), kojom se
definiraju završeci na limu, u različitim oblicima, a ovdje
je korišten Tear Drop oblik. Na slici 8 prikazano je
bušenje rupe na dijelu Ladica_prednja. Pozicija rupe lako
se određuje korištenjem funkcije Smart Dimension. 

 It is possible to execute bending with the use of the 
advanced Miter Flange function, but every bending after 
the Base Flange Element is then defined with a slower 
speed. One more function used in the manufacture of the 
drawer is Hem (figure 7), with which the endings on the 
sheet metal are defined, in different shapes, and here the 
Tear Drop shape was used. In Figure 8, drilling of a hole 
on the part of the Drawer_front is shown. The position of 
the hole is easily selected with the function Smart 
Dimension. 
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Slika 7. Prikaz završetka korištenjem funkcije Hem 
Figure 7.  Representation of ending with the use of Hem function 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Slika 8. Prikaz završetka korištenjem funkcije Hem 
Figure 8 Representation of ending with the Hem function 
 
Pri modeliranju korištena je i funkcija Miter Flange kao 
što je to prikazano na slici 9. Funkcija Miter Flange
koristi se kako bi se dodali rubovi koji spajaju i
automatski kreiraju potrebne rubne rezove. Nakon
zrcaljenja polovice ladice korištenjem funkcije Mirror
napravljen je model do čijeg je razvijenog oblika vrlo 
jednostavno doći naredbom Unsupress Flat Pattern (slika 
10) te je kao takav spremljen u IGES format i spreman za
prijenos u ToPs program [4, 5]. 

 In modelling, the function Miter Flange was used as it is 
shown in Figure 9. The Miter Flange function is used in 
order to add edges that connect and automatically create 
the necessary cuts. After mirroring half of the drawer 
with the use of Mirror function a model is created with 
which is very easy to arrive at the developed shape, with 
the order Unsupress Flat Pattern (Figure 10), and as such
it is saved in IGES format and ready for transfer into the 
ToPs program [4, 5]. 

 
 
 
 
 
 
 
 
 
 
 

 
Slika 9. Prikaz korištenja funkcije Miter Flange 
Figure 9.  Representation of the use of Miter Flange function  
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Slika 10. Razvijeni oblik dijela Ladica_prednja  
Figure 10.  Unfolded shape of the part Drawer_front 
 
Zadnja je faza u konstrukciji ladice stvaranje sklopa. To 
se radi tako da se odabere funkcija Assembly i umetnu se
svi dijelovi ladice na način da se postave međusobne
relacije. Sparivanje dijelova vrši se korištenjem funkcije
Mate  tako da se odaberu plohe, rubovi, ravnine i sl. koje
se želi spariti. Standardne opcije sparivanja su:  

• Kut; 
• Podudarnost; 
• Koncentričnost; 
• Udaljenost; 
• Paralelnost; 
• Pravokutnost i 
• Tangencijalnost. 

Sve su te vrste sparivanja uvijek prikazane pod 
PropertyMenagerom, ali samo one vrste sparivanja koje
su primjenjive na trenutni odabir. Na slici 11 prikazan je
sklop koji sadrži sve dijelove ladice. Na lijevoj strani
prikazana su korištena sparivanja. Budući da se radi o
dijelovima ladice koji imaju većinom ravne površine, to 
su uglavnom oslanjajuće površine, te su stoga korištene
vrste sparivanja paralelnost i podudarnost. 

 The last phase in drawer construction is assembly 
creation. The method in which this is done is that the 
Assembly function is selected and all parts of the drawer 
are inserted in such in a way that mutual relations are 
configured. The joining of parts is executed with the use 
of the function Mate by selecting the surfaces, planes, 
edges and etc. that we wish to join together.  
Standard options of joining are: 

• Angle; 
• Coincident; 
• Concentric; 
• Distance; 
• Parallel; 
• Perpendicular and 
• Tangent. 

All these types of joining are always shown under the 
Property Manager, but only those types of joinings that 
are applicative to the current selection. In Figure 11, an 
assembly is shown that contains all parts of a drawer. On 
the left part, the joinings that are used are shown. Because 
this concerns the parts of drawer whose surfaces are 
mostly straight, these are mostly the support surfaces; the 
types of joining used are parallel and coincident. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Slika 11. Prikaz sklopa ladice i pripadajućih sparivanja 
Figure 11.  Representation of drawer assembly and accompanying joinings  
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3. ZAVRŠNA IZRADA U TOPSU 
 
Kada je modeliranje svih dijelova u SolidWorksu
završeno i nakon što je kreiranjem sklopa potvrđena
dimenzijska ispravnost svih dijelova, može se pristupiti
izradi CNC programa. Izrada CNC programa predstavlja
prije početka proizvodnje zadnji korak u izradi ladice. 
Izrada CNC programa vrši se za priliku ovog rada
upotrebom sustava programiranja za probijanje i
kombiniranu obradu ToPs 300 [6]. Dijelove ladice za tu
je priliku potrebno spremiti u .iges format kako bi ToPs
300 mogao koristiti modele. Nakon unosa crteža bilo je 
potrebno obaviti optimizaciju procesa obrade za stroj
Minimatic 100, napraviti gniježđenje i simulirati obradu.
Kada su postignute željena tehnika i strategija procesa,
sve je spremno za izradu CNC programa koje softver
ToPs 300 automatski generira. Na slici 12 prikazan je dio
radnog naloga koji ToPs automatski generira pri izradi
programa. Na radnom nalogu prikazuju se svi bitni 
podaci potrebni za proizvodnju. Nakon izrade svih
dijelova ladice potrebno je saviti dijelove strojem Schiavi 
Hfb 50-20 kako bi se dobili konačni oblici. Kada su 
dobiveni konačni oblici prema lancu procesiranja limova,
potrebno je napraviti završnu obradu koju predstavljaju 
čišćenje dijelova te sklapanje, kako bi se dobio konačni 
oblik ladice prikazan na slici 13. 
 

 3. FINAL CREATION IN TOPS  
 
When the modelling of all parts in SolidWork is finished, 
and after the dimensional accuracy of all parts with the 
creation of assembly has been verified, the creation of the 
CNC program can begin. Creation of the CNC program 
represents the last step in the creation of a metal drawer
before production. The creation of a CNC program in the 
case of this paper, is done with the use of the ToPs 300
[6] system of programming for punching and combined 
production. It is necessary to save parts of the drawer for 
this occasion in the .iges format, in order that ToPs 300 
can use the models. After the import of a drawing, it is 
necessary to do an optimisation of the production process 
for the machine Minimatic 100, to create a nesting and to 
simulate the production. When the desired technique and 
strategy of the process has been obtained, everything is 
ready for the creation of a CNC program, which the 
software ToPs 300 automatically generates.  In Figure 12,
a piece of work order is shown that ToPs automatically 
generates while creating the program. In the work order,
all important data necessary for production are shown. 
After creation of all parts of the drawer, it is necessary to 
bend all parts on  a Schiavi Hfb 50-20 machine in order to 
gain the final shapes. When the final shapes have been 
obtained according to the sequence of sheet metal 
processing, it is necessary to create the final production 
that is represented by the cleaning of parts and the 
assembly of parts, in order to gain the final shape of the 
drawer shown in Figure 13. 

 
Slika 12. Dio radnog naloga u TOPS-u 
Figure 12.  Part of a work order in TOPS 

 
Slika 13. Izrađena ladica 
Figure 13.  Created drawer 
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4. ZAKLJUČAK 
 
Upotreba softvera CAD-CAM omogućila je mnogo
manje potrebnog vremena kako bi se traženi proizvod
mogao konstruirati, izraditi potrebni crteži, optimizirati
strojeve, izraditi CNC programe te ih jednostavno poslati
na stroj za početak proizvodnje. Ovaj rad predstavio je
takvu CAD-CAM proizvodnju. Prikazano je
konstruiranje ladice od lima upotrebom softverskog
paketa SolidWorks, izrada crteža upotrebom računala,
odabir potrebnih strojeva, te izrada CNC programa
korištenjem softvera ToPs 300.  U nastavku ovog
istraživanja primijenit će se pristup utvrđivanja
oblikovanja deformiranjem zasnovan na procjeni
deformacijske energije i optimiziranog modeliranja
povezanog s CNC programiranjem i definiranjem
tehnologija oblikovanja. Pristup deformacijske energije
bit će izveden pomoću Abaqus [7] programa radi
procjene ovisnosti deformacijske energije o varijaciji
ulaznih oblika dijelova ladice prije razrade njihova
razvijenog oblika u SolidWorksu i prije njihove 
proizvodnje na strojevima. 
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5. POPIS OZNAKA 
 
radijus savijanja                                         R,           mm 
K-faktor                                                     K, 
debljina materijala                                     T,            mm 
udaljenost do neutralne plohe                    t,             mm 
kut savijanja                                              A,             °
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 4. CONCLUSION 
 
The use of CAD-CAM software has ensured less time 
required in the construction of the required product, 
creation of the necessary drawings, optimisation of the 
machines, and creation of CNC programs and also the 
simple act of sending them to a machine for the beginning
of production. This paper presents one such type of 
CAD-CAM production. The construction of a sheet metal 
drawer has been shown by the use of the software
package SolidWorks, the creation of drawings by the use 
of a computer, the selection of necessary machines, and 
the creation of CNC programs by use of the software
ToPs 300. In the following investigation, the approach 
used in establishing the forming process based on strain 
energy evaluation and optimized modeling connected 
with CNC programming and forming technology 
definition will be applied. The strain energy approach, by 
means of Abaqus [7] software, will be used to assess the 
dependency of the strain energy on the variation in input 
shapes of parts of the drawer before the elaboration of 
their developed shape in SolidWorks and before their 
production on machines.  
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